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Welcome to Ulead DVD MovieFactory
Ulead DVD MovieFactory provides you with the answer to your disc-authoring 
needs. Instantly create Blu-ray, HD DVD, DVD, VCD, and SVCD video or slideshow 
discs through a user-friendly, wizard-type process and specific task oriented 
features. You can also enhance your video by adding transition effects, text, audio, 
interactive menus, and many others, or print disc label or cover to make your discs 
more attractive and interesting.

With DVD MovieFactory, creating professional-looking video or slideshow discs has 
never been easier.

DVD MovieFactory launcher
The DVD MovieFactory launcher (run from the icon on the desktop, Start menu, or 
from the program folder) serves as a control panel where you can find the tasks for 
disc editing and authoring.

Note: The availability of program modules depends on the DVD MovieFactory version 
you have.
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To use the launcher:
1. Select a task by clicking the Video Disc, Slideshow Disc, Audio/Data Disc, 

Import, Edit Disc, Copy Disc, or Disc Tools icon.

2. Select an associated task option at the right hand side.

Video Disc 
Click to create a new project, open an existing one, or perform other burning tasks. 
See “Video Disc” for more details.

Slideshow Disc
Click to create a new slideshow project or open an existing one. See “Slideshow 
Disc” for more details.

Audio/Data Disc
Click to create an MP3, Audio CD, DVD-Audio, Music DVD-Video, or data disc. See 
“Audio/Data Disc” for more details.

Import
Click to capture content from your camcorder and other devices or import content 
from a DVD or CD. See “Import” for more details.

Edit Disc
Click to append data or edit video/MP3 files on a disc. See “Edit Disc” for more 
details.

Copy Disc
Click to create a copy of a disc or convert DVD and video formats for use on your 
projects. See “Copy Disc” for more details.

Notes:

• You can also click any tool icon located at the lower part to set project preferences, 
view disc and burner information, create disc labels, or copy movies using 
DVDCopy.

• Opening previously created project files from outside the DVD MovieFactory 
launcher will automatically launch the associated program.
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Disc Tools
Click to format, erase, or finalize a disc. See “Disc Tools” for more details.

Preferences
Click to set your working folder, view product updates, register online, or view 
program information.

Disc information
Click to view the properties of the disc in your CD or DVD burner.

Drive information
Click to view the properties of your CD or DVD burner.

Label@Once
Click to open Ulead Label@Once and create a label for your CD or DVD disc. See 
“Label@Once” for more details.

DVDCopy
Click to open InterVideo DVDCopy and copy movies, backup data discs, and merge 
multiple video files to a single disc  3 steps. See “DVDCopy” for more details.  
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Video Disc
Ulead DVD MovieFactory's step-by-step interface makes creating movies simple 
and easy. To create a video disc, click Video Disc on the Launcher and select an 
associated task. To create a new project, click New Project. Select your output 
disc type in Create Video Disc and click OK.

• Blu-ray A format that allows recording, rewriting and playback of high-
definition video (HD). A single-layer Blu-ray Disc can hold 25GB and can 
record over 2 hours of HDTV or more than 13 hours of standard-definition TV. 
There are also dual-layer versions that can hold 50GB.

• HD DVD (High Density Digital Versatile Disc) Developed as a standard 
for high-definition DVD, HD DVD is similar to the Blu-ray Disc, which uses a 
120 mm diameter optical data storage media and 405 nm wavelength blue 
laser.

• DVD Abbreviation for Digital Versatile Disc, a popular format in video 
production because of its superb audio and video quality. It also holds several 
times more data that VCDs and SVCDs.

• VCD (Video Compact Disc) is a special version of a CD-ROM that uses the 
MPEG-1 format. The quality of the exported movie is almost the same, but 
usually better than VHS tape-based movies. A VCD can be played back on a 
CD-ROM drive, VCD player, and even on a DVD player. 

• SVCD Abbreviation for Super Video CD, commonly described as an enhanced 
version of a VCD. It is based on MPEG-2 technology with either Variable Bit 
Rate (VBR) or Constant Bit Rate (CBR).

• DVD-RAM/RW Like random access memory (RAM), DVD-RAM/RW can be 
read, recorded on, and erased repeatedly.    

• DVD VR A DVD recording format that allows you to produce a DVD movie 
that can be directly edited on the disc. DVD+VR is used on DVD+RW disks. 
DVD-VR is used on DVD-RW disks.

To edit an existing project, select Open Existing Project and browse for the 
project file. Creating a new project or opening an existing one takes you to Select 
source and import (Step: 1/3).

Note: You can select other options to capture your video and burn directly onto a 
DVD or BD or burn disc image files and DVD folders.
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Select source and import (Step: 1/3)
In Select source and import (Step: 1/3), you can add media files, modify them 
or enhance their quality, create chapter points, import and export clips, and view 
file information among others.

Add Media
You can add content to your movie by capturing videos, adding video files, creating 
and adding slideshows, and importing DVD videos.

 Capture video 

See “Capture from devices” for more details.

 Add video files

DVD MovieFactory allows you to add video files of different formats such as AVI, 
MPEG, and WMV into your video project. You can also add a VideoStudio project 
(.VSP).

Options for 
adding media

Current 
project type

Toggle between showing and hiding advanced options
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To add a video file to your project:
1. Click Add video files in the Select source and import (Step: 1/3) page to 

launch the Open Video File dialog box.

2. Locate the video file(s). You can select and add multiple files under the same 
folder. Press [Ctrl] or [Shift] to select multiple files.

3. Repeat the above process to add more video files.

 Add photo slideshow

See “Slideshow Disc” for more details.

 Import DVD video or DVD-VR files from a disc or hard drive

See “Import from DVD” for more details.

Edit Media
After importing the media files into your project, you can now play and edit the 
content using DVD MovieFactory’s playback controls and editing tools.

When editing, there are many ways to browse through a video clip. You can use the 
navigation control buttons or go to a specific timecode. You can also use the Jog 
Wheel, which works the same way as the one found in most VCRs, to browse 
through the video more quickly. Or you can use the Shuttle Slider to view the 
video clip at a constant playback speed.

Tip: When using the Jog Wheel, you can browse through a video by moving the scroll 
wheel on the mouse back and forth.

Jog Slider

Jog Wheel

Shuttle Slider
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The right-click menu
Right-click a thumbnail in the Media Clip list to display a context menu that gives 
you access to more options.

• Move Left/Right Changes the position of the selected clip in the Media Clip 
list. 

• Change Thumbnail Changes the current thumbnail display.

• Reset Thumbnail Restores the original thumbnail display.

• Reset Enhanced Video Removes all enhancement made in the Enhance 
Video dialog box.

• Recover Possible Lost AV Data Retrieves lost data from captured videos.

• Audio Output Setting Includes audio data when exporting video.

• Media Clip Properties Displays the file, video, and audio properties of the 
selected media clip.

• Export Video Allows you to save your video into a specific format.

• Delete Video Removes the selected clip from the Media Clip list.

Trimming a video
You can trim a video using the Jog Slider, mark-in/out buttons, navigation 
controls, Shuttle Slider, and Jog Wheel. Trimming allows you to modify the 
length of the video according to your needs.

To trim video:
1. Select a video thumbnail in the Media Clip list.

2. Use the navigation controls or drag the Jog Slider to where the clip will start 

and click  or press [F3]. Alternatively, simply drag Mark-in to the starting 

point.
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3. Use the navigation controls or drag the Jog Slider to move to the point where 

the clip will end then click  or press [F4].

4. Click Play (or press [Space]) to view the trimmed video.

 Multi-trim Video

Multi-trim Video lets you select multiple segments from a video and extract these 
segments to the Media Clip list.

To use Multi-trim:
1. Select the video to be trimmed in the Media Clip list.

2. Click  to open the Multi-trim Video dialog box. 

3. Drag the Jog Slider to locate the start of the segment to retain, and then click 

 or press [F3].

4. Drag the Jog Slider to locate the end of the segment to retain, and then click 

 or press [F4]. The extracted segment will be added to the Media Clip list.

5. To select more segments, repeat steps 3 and 4.

6. Click OK.

Note: If the video is previously edited by Enhance Video, you must first right-click 
the video and select Reset Enhanced Video before you can multi-trim the clip.

Tip: To move the Jog Slider at a fixed interval, use  or . Set the quick search 
interval in Duration.

Tips: 

• Quick search interval allows you to set a fixed interval between frames and 
browse through the movie using the set value.

• You can also click Invert Selection to select all unmarked segments instead.

Tips:

• Click  Play Trimmed Video to view the extracted segments.
• To remove any extracted segment from the list, select it in the Media Clip list and 

click Remove selected clips.
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 Ad-Zapper

Ulead DVD MovieFactory lets you search your videos for commercial intervals. 
Clicking this feature extracts the commercials to the media list. 

Detection sensitivity allows you to control the rate of distinguishing between 
commercials. 

Merge CF

This feature merges all your extracted clips so that they appear as one thumbnail in 
your media list. 

 Join/Separate videos

You can combine two or more video clips, or separate previously combined video 
clips using the Join/Separate Video feature.

To combine/separate video clips:
1. Press [Ctrl] or [Shift] and click on two or more clips in the Media Clip list.

2. Click  to combine the selected clips.

3. To separate the previously combined videos, select the video clip from the 

Media Clip list and click .

 Enhance Video/Edit Slideshow

Select a video clip and click Enhance Video to add transition effects, audio, and 
text to your video.

To manually add transition effects:
1. In the Effect tab, drag the Jog Slider or use the playback controls to move 

between frames in the video. Stop when you reach the point where the effect 
will be added.

2. Select a transition effect from the list, and enter the duration.

3. Click Add to Current Position.

4. Repeat steps 2 to 3 to add more transition effects. You can use the playback 
controls to preview the results.

5. Click OK.
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The Text tab
The Text tab allows you to add and format text.

To add text to your video:
1. In the Text tab, drag the Jog Slider or use the playback controls to move 

between frames in the video. Stop when you reach the point where the text will 
be added.

2. Double-click the Preview Window to enter the text. Specify the duration, font 
type, size, color, and other properties. You can also use the mark-in/out buttons 
to set how long the text clip will be displayed on screen. Click Mark-in to mark 
the starting point of the clip and Mark-out to mark the ending point.

3. Repeat steps 1 to 2 to add more text. You can use the playback controls to 
preview the result. The text will not overlap each other. 

4. Click OK.

Options for the Text tab
• Added text list Records all the text strings that have been added. Use this list 

to select the text to edit or remove.

• Delete Click to remove the selected text from the video.

• Duration Specify how long the text will be displayed.

• Vertical text Changes the orientation of the text vertically.

• Transparency Enter a value or drag the slider to adjust the transparency of the 
text.

• Shadow Applies shadow to your text.

• Show/Hide shadow attributes Toggles between showing and hiding the 
settings for the text shadow.

• X-offset Determines the horizontal distance between the text and the 
shadow.

• Y-offset Determines the vertical distance between the text and the shadow.

• Transparency Enter a value or drag the slider to adjust the shadow 
transparency of the text.

Tip: To modify or delete the added text, select it in the Added text list then apply 
preferred settings or click Delete.
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The Audio tab
The Audio tab allows you to add audio to your video.

To add audio:
1. In the Audio tab, click Add Audio to locate the audio file to add. The added 

audio files are displayed on the list below Add Audio.

2. To preview and trim an audio file or apply fade-in/out effects, click Set audio 

properties . The duration of all audio files in your project is displayed in 

Total duration.

3. To add a voice annotation to your video, drag the Jog Slider or use the playback 
controls or the Jog Wheel to move between frames in the video. Stop when you 

reach the point where the annotation will be inserted. Click Record Voice  

and test your microphone (adjust the volume as needed), then click Record to 
start.

4. To remove a previously recorded annotation, select it from the Recorded voice 

list then click Delete .

5. Adjust the volume for the original audio track, additional audio file, and recorded 
voice annotations respectively. Click Play to preview the result.

6. Click OK.

Options for the Audio tab
• Add Audio Click to locate an audio file to be used as background music for your 

video. The added audio files are displayed on the list below it. 

• Record Voice Click to record and add voice annotations to your video.

• Mix audio Enter the specific value or move the slider to adjust the volume level 
for the Original, Additional, and Voice audio tracks respectively.

• Mute Click to disable a specific audio track.

Note: Even if the audio is trimmed or edited, the actual audio playback duration 
remains the same as the video playback duration. Audio playback will loop if the 
video duration is longer.
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The Effect tab
The Effect tab displays various options that you can use to apply transition effects 

to your video clip. You can also add a transition effect anywhere in the video.

Options for the Effect tab
• Auto Add Effects Click to automatically add transition effects based on the 

scene changes or chapters of a video title.

• Only for joined videos Select to automatically insert transition effects in 
between videos that are joined together. This option works only with Auto Add 
Effects.

• Duration Allows you to specify the length of the selected transition effect. 

• Add to Current Position Click to add the selected transition effect to the frame 
currently displayed on the Preview Window.

• Added effect list Select an applied transition effect to edit or remove. 

• Delete Click to remove the selected transition effect from the video.

• Delete All Click to remove all previously applied transition effects.

• Auto enhancement Applies automatic brightness and contrast adjustments to 
your video clip.

Add/Edit Chapters
Through this option, you can create submenus linked to their associated video 
clips. See “Select a template to create menu (Step 2/3)” for more details.

Represented as a video thumbnail in a submenu, each chapter is like a bookmark 
for a video clip. Viewers can easily select a chapter, then the video clip will 
immediately jump to the first scene of that chapter and start the playback. 

This feature gives your viewers the freedom to choose a particular part of the 
movie to watch. Note that these small video thumbnails only link to its “mother” 
video without generating any additional physical video files. So, you don’t need to 
worry about the possibility of unexpected file size increase. 

Note: Click Auto Add Effects to easily add transition effects. DVD MovieFactory will 
scan the video for scene changes and add a transition effect at every point of the 
scene change.
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You can create up to 99 chapters for a video clip. If the Create menu option is not 
selected, you will be guided to the Preview step immediately without creating any 
menus after clicking Next.

To create or edit chapters linked to a video clip:
1. Select a video in the Media Clip list.

2. Click Add/Edit Chapter . The Add/Edit Chapter dialog box opens.

3. Click Auto Add Chapters . You can also drag the Jog Slider to move to a 

scene to use as the first frame of a chapter and click Add Chapter . Repeat 

this step until all chapter points have been added.

4. Click OK.

Use Remove Chapter or Remove All Chapters to delete unwanted chapters.

Export Selected Clips
This lets you select existing video files and save them to another video file format.

To export selected clips:
1. Select the video files from the Media Clip list in the Select source and import 

(Step: 1/3) page.

2. Click Export selected clips  and select from a list of file format templates. 
Select HD-1440 to save your video in 1440 X 1080 resolution or select HD-
1920 to output in 1920 x 1080 resolution format. Select Fast Export DVD 
Compliant Video to save a DVD, VCD, or SVCD video. Fast Export Video lets 
you export a non MPEG video file to the same format without having to convert 
it. Select Customize to save to other formats.

3. Locate the folder where you want to save these files, and then enter a new file 
name.

Tips:

• To use Auto Add Chapters, your video must be at least one minute long or have 
scene change information.

• If you click Auto Add Chapters and your video is a DV-formatted AVI file captured 
from a DV camcorder, DVD MovieFactory can automatically detect scene changes 
and add chapters accordingly.

• If the selected video is an MPEG-2 file with scene change information, DVD 
MovieFactory automatically detects each scene change and generates it as a 
chapter when you click Auto Add Chapters.
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4. Click Save.

Select a template to create menu (Step 2/3)
To create menus and submenus, select Create menu in Select Source and 
Import (Step: 1/3). Clicking Next takes you to Select a template to create 
menu (Step 2/3). 

Menus allow the viewers to instantly access specific portions of your video. DVD 
MovieFactory offers a set of menu templates to best fit the purpose of each menu. 
Custom-made menus are also easily created.

See the illustration below to better understand the menu structure.

In this example, Clip 1 has three chapters. When you click the Clip 1 video 
thumbnail, it will jump to submenu #1. If you look at Clip 2, it has no chapters 
assigned to it. Therefore, there is no submenu for Clip 2.

Note: You can also export more than one video clip. The file name you entered 
followed by a serial number will be used as file name for the succeeding clips that you 
export.
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Menu template categories
Menu templates are located in the Gallery tab of the Select a template to create 
menu (Step 2/3) page. They are grouped in various categories depending on 
your project type.

SmartScene Menus uses both text and thumbnails. Hovering your mouse pointer 
over a chapter point text shows the thumbnail for that specific chapter. Selecting 
other text shows the corresponding chapter thumbnail. 

The most commonly used menu type is Thumbnail Menus. The chapter points 
that you have previously created are represented as scene thumbnails. Clicking a 
thumbnail plays back the movie starting from the said chapter point.

Text Menus is a category that uses texts to represent chapter points. Selecting a 
text title plays back the movie from the corresponding chapter point.

Applying menu templates
To apply a menu template for your project:
1. In the Select a template to create menu (Step 2/3) page, select the menu 

to modify in Currently displayed menu.

2. In the Gallery tab, select a template layout category. 

3. Click a template layout thumbnail to apply it.

Editing menu templates
You can modify your menu template by selecting various options on the Edit tab.

• Background music Opens a menu of options for selecting or deleting audio 
files used as background for your menus.

• Motion menu Sets the duration for the moving elements in the menu. See 
“Using motion menus” for more details.

• Background image/video Opens a menu of options for selecting or deleting 
image or video files used as backgrounds for your menus. When you choose a 
video as menu background for your VCD or SVCD project, however, only the 
first frame of the video will be set as the menu background. 

• Font Settings Opens a menu of options for font properties used in the menu 
template

Note: The SmartScene Menus type is not supported in Straight Capture to Disc 
projects.
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• Layout Settings Opens a menu of options for applying changes to menu 
pages or resetting them to their previous state.

• Advanced Settings Opens a menu of options for adding title menus, chapter 
menus, and thumbnail numbers.

• Customize Opens the Customize Menu dialog box where you can modify 
the layout, thumbnail frames and navigation buttons of your menu.

• Menu In/Menu Out Opens a selection filters and transition effects. If a menu 
template has a Menu In effect, its default duration is 20 seconds.

 

To switch to preview mode, click Go to the Preview step. 

Using motion menus
When Motion menu is selected, the movie will use the beginning part of the video 
at a fixed duration instead of the first video frame as button thumbnails. The 
duration of motion menus range from 1 to 30 seconds.

Using motion menus will increase the file size. Check the disc space usage indicator 
to make sure that the file size is still within the limit of the DVD. Refer to the 
Required menu space to make sure the space for the menu does not exceed the 
menu space limit of your selected output.

Use video backgrounds and buttons to enhance the appearance of your menus. 
Select a customized template first then choose a video for your buttons or 
background.

Customizing menu templates
Ulead DVD MovieFactory allows you to customize and create your own menu 
templates for easy application to your current and future movie projects.

To create your own menu template:
1. Click Customize in the Edit tab of the Select a template to create menu 

(Step 2/3) page to open the Customize Menu dialog box.

2. Select Frame, Navigation Button, or Layout in the drop down menu to 
display the associated preset thumbnails.

3. Double-click a thumbnail to apply it.

4. To choose a new background music, image, or video, click Background music 
or Background image/video.

Note: The Menu Out transition effects are not supported in DVD+VR projects.
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5. You can rotate text in the Preview Window of the Customize Menu dialog box 
using the rotate handle. To modify the text description, select the text and click 
Font Settings. This opens the Font dialog box where you can select apply text 
attributes.

6. To set menu pan and zoom effects, click Pan & Zoom. Select the category and 
your desired effect.

7. To set menu motion filter effect, click Motion Filter. Select your desired motion 
effect.

8. To modify menu in/menu out effect, click Menu In/Menu Out.

9. To save the menu template for later use, click Add to Menu Template.

10.Click OK.

Use the Preview Window in Select a template to create menu (Step 2/3) to 
further manipulate and modify your menu objects. See “Manipulating objects” for 
more details.

Manipulating objects
You can resize and rotate a menu placeholder by clicking it and dragging the 
handles. You can also move and align menu objects anywhere in the Preview 
Window.

To easily align objects in your menu, right-click the Preview Window and select 
Show Grid Line. You can use these grid lines as reference when dragging the 
menu objects to the desired position. Make sure that the objects are within the TV 
safe area (defined by a border with dotted lines). You can also restore the original 
layout of the menu pages by selecting Reset this Page. 

Note: When working in the Customize Menu dialog box, use the Font dialog box to 
accurately resize text. The Font dialog box can also be launched by right-clicking the 
text and selecting Font Attributes.

Note: To use your menu template, go to Menu template library at the Select a 
template to create menu (Step 2/3) page and select Favorites from the list. 
Double-click your menu template to apply it.
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Editing menu thumbnail and text style
After customizing your menu pages, you can edit your menu objects by double-
clicking them in the Preview Window. Double-click a frame, button, or text object 
to modify it. You can also right-click on these objects and select various options.

Layout settings
You can then choose to apply the same settings to other menu pages in your 
project. To do this, click Layout Settings in the Options Panel and select Apply 
to All Pages of this Menu.

Preview
Now, it’s time to view your video project and do a final check before you burn it 
onto a disc.

To preview your video project:
1. If you created menus for your project, click Go to the preview step in the 

Select a template to create menu (Step 2/3) page to go to the preview 

page (Press Play button to start preview). Otherwise, click Next. 

2. Click Play  to watch your video project and test the menu selection on 

your computer. Use the navigation controls as you would use a standard remote 
control of a home DVD player.

3. Click Volume control  to adjust the audio volume of your computer as you 

preview your video project.
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4. Click Next to proceed to the final step -- Press Burn button to create a DVD 
(Step: 3/3) and setup the output settings for your project and burn it onto a 
disc.

Press Burn button to create a DVD (Step: 3/3)
This is the final step in the disc-authoring process. In Press Burn button to 
create a DVD (Step: 3/3), specify the settings for burning your videos or 
creating disc image files.

To burn your project onto a DVD:
1. Specify the settings of your burning device in Disc burner.

• Label Enter a volume name of up to 32 characters onto the CD/DVD.

• Drive Select the disc burner that you want to use to burn the video file. 

• Copies Set the number of disc copies to burn.

• Disc type Displays the output disc format for the current project.

2. Select your burning tasks and other output options. Click / to show/hide 

output options.

• Create to disc Select to burn your video project onto a disc.

• Create DVD/HD DVD folders This option is only enabled when the video file 
being created is a DVD/HD DVD video. This allows the user to view the 
finished file on the computer using a DVD player software. 

• Create disc image Select this option if you plan to burn the video file several 
times. By selecting this option, you don't have to generate the file again when 
you want to burn the same video file.

• Normalize audio Select to prevent irregular audio levels during playback of 
your movie. Different video clips may have different audio recording levels 
when created. When these video clips are put together, the volume could vary 
greatly from one to another. To make volume levels consistent between clips, 
Normalize audio function evaluates and adjusts the audio waveform of the 
whole project to assure a balance audio level throughout the video.

• Archive images of slideshows Select to include images used in your 
slideshows on the disc.

Tip: As you mouseover the controls, tooltips display their specific functions.
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• Power off the PC when completed Select to automatically turn off your 
computer after the burning process.

3. Click Burn  to start the burning process.

4. After successfully burning your disc, a dialog box appears from which you can 
select the next step.

• Return to Start page allows you to save the current project and begin a 
new one.

• Continue brings you back to the Press Burn button to create a DVD 
(Step: 3/3) page where you can burn another copy of your project or burn a 
new disc with a different series of settings.

• Close prompts you to save your work and close DVD MovieFactory.

Required space

Use the following indicators as reference when burning your projects. These 
indicators help determine if you have sufficient space to successfully burn your 
project onto the disc.

• Required/Available hard disk space Displays the space needed by the 
working folder of the project and the space available for use in the hard drive.

• Required/Available disc space Displays the space needed to fit the video 
file in the disc and the space that is available for use.

.

Delete temporary files from folders  removes all unnecessary files in your 

working folder. Erase  deletes all the data in the rewritable disc.

Tip: Click More settings for burning  to define additional burner and output 

settings.

Notes:

• Make sure your project does not exceed 4.37 gigabytes when burning onto a 4.7-
Gigabyte DVD disc.

• If you will burn a DVD with nearly 2 hours of video, consider these options to 
optimize the project size: use a video data rate not higher than 4000 kbps, use 
MPEG audio, or use still image menus instead of motion menus.
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The Burning Options dialog box
The various options in the Burning Options dialog box determine how your discs 
are burned.

• Disc burner Specify the settings for your burning device.

• Drive Select the disc burner to use in recording the video file. 

• Speed Select the recording speed to use in burning the video file.

• Files to include on disc Choose additional items that you want to include on 
the disc.

• Copyright information Includes copyright text or information about the 
author. 

• Project file Select to include the DVD MovieFactory project file that you 
created on the disc for later use.

• Personal folder Select to include any other folders on the disc. 

• Advanced settings Lets you adjust more disc burning settings.

• Test before burning Select to simulate first (it does not actually burn yet) 
the CD/DVD burning of the video file. This will help you check if the system 
speed is enough to send data to the CD/DVD writing device at a specified 
recording speed. After the simulated burning, actual burning then starts. 
Clear to burn the disc without performing a test.

• Buffer underrun protection Select to use this technology when burning 
your video file. This technology helps eliminate the buffer underrun problem. 
Availability of this technology depends on the disc burner you are using. 

• Restart DVD+RW background format Select to format the DVD+RW 
before recording. Enabling this option will prolong the recording process but 
will ensure a successful burn. This is recommended when you are using the 
DVD+RW disc for the first time.

 

• Do not close disc Select this function to create a multi-session disc for CD-
R/CD-RW/DVD-R/DVD-RW/DVD+R.

Note: By default, this option is not selected to ensure maximum compatibility.
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Straight Capture to Disc
Straight Capture to Disc provides you with a fast way to capture videos from a 
video device (such as DV camcorder, VCR, or TV) through an analog or IEEE-1394 
(FireWire) interface card, and then burn them directly onto a video disc. When this 
task is selected, DVD MovieFactory will initially check both your burner and disc to 
ensure that there are no problems with your output device and media. Then, you 
can set up your menu template as well as capture options and adjust other 
settings.

For DVD, VCD, or SVCD

With Straight Capture to Disc, you can capture your videos and directly burn 
them onto DVD, VCD, or SVCD.

To capture videos directly onto a disc:
1. Make sure your video source is switched on and properly connected to your 

computer.

2. Insert a disc into the disc burner where the video will be recorded, and then click 
Video Disc and select Straight Capture to Disc in the Launcher.

3. Select a recording format. The options vary depending on the selected output 
disc format.

4. Select the Source device to capture from.

5. Set the video length to record in Duration .

6. Click Create Menu to set up the menu for your video project.

7. Select the menu template and click Background Image or Background Music 
to add background image and music, then click OK.

8. Click Create Chapter to automatically add chapters with a specific time 
interval.

9. Select the desired output format in Format. 

10.Click Burner Options to set the disc burner options and properties. See “The 
Burning Options dialog box” for more details. Select Support X-Disc to include 
Extended disc (XDVD, XVCD, XSVCD) compatible files to your project.

11.Locate the starting point of your video to capture then click Start Capture. 
Click Pause Capture to pause the capturing process. Click Stop Capture to 
end the capturing process.

Notes: 

• Straight Capture to Disc does not support 16:9 video.
• You cannot append titles in Straight Capture to Disc.
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12.After successfully burning your disc, a dialog box appears from which you can 
select the next step.

• Return to Start page returns to the launcher.
• Continue stays in the Straight Capture to Disc dialog box for you to do 

another direct-to-disc task. 
• Close exits DVD MovieFactory.

Straight Capture to BD
You can capture videos and burn them directly onto a Blu-ray disc (BD) using 
Ulead BD DiscRecorder. You may refer to the BD DiscRecorder User Manual 
for details.

Settings and tools
The following tools located at the lower left of the main interface allow you to 
perform various tasks. See “Tools” for more details.

Settings and Options Allows you to set preferences, save projects, view the 
online Help, and access product specific information on the Ulead Web site.

Project Settings Opens a dialog box where you can configure project specific 
settings.

Display Aspect Ratio Toggles between standard 4:3 and widescreen 16:9 display 
aspect ratios for videos and menus.

Label@Once Launches the Label@Once dialog box where you can create and print 
labels and covers for your discs.

Help Opens the Ulead DVD MovieFactory online Help.

Note: Click Expand/Shrink preview window to enlarge the Preview Window 
and minimize the other options in the Straight Capture to Disc dialog box. This 
gives a larger view of your video. Click Expand/Shrink preview window again to 
return to the default Preview Window size and layout. See “Capturing DV video” for 
more details.
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16:9 DVD
In addition to the standard 4:3 display, DVD MovieFactory supports 16:9 display 
aspect ratio for videos and menus. This lets you create widescreen videos and burn 
them onto a DVD disc.

To create widescreen videos, click  and select 16:9 from the Display aspect 
ratio list in the Project Settings dialog box. The video clips and menus are then 
adjusted automatically.

You can also switch between standard 4:3 and widescreen 16:9 by clicking Display 
Aspect Ratio and selecting the desired setting. See “Display aspect ratio” for more 
details.

You can change the output format of your current project anytime by selecting the 
desired output format in Current project type.

Slideshow Disc

Adding photo slideshows
Aside from video files, you can also add photo slideshows complete with multiple 
background music or sound annotations, as well as transition and pan & zoom 
effects.

To create a slideshow:
1. Click Slideshow Disc and select New Project in the Launcher to open the 

Select source and import (Step: 1/3) page.

2. Click Add Slideshow to open the Add Slideshow dialog box.

3. Locate the folder that contains your image files in the Add SlideShow dialog 
box and select the images to include. Use [Ctrl] or [Shift] to select multiple 
images.

4. Click Add Photo. Repeat steps 2 and 3 to add more images.

Note: Switching between 16:9 and 4:3 display settings resets all menus to default.

Note: To add image folders and subfolders by group, select Batch Collect.
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5. Add a slideshow title, background music, and transition effect as needed. You 
can also apply Pan & Zoom effect to animate your background image by 
moving it from one fixed point to another and by changing the viewing distance. 
Click Preview to see the result.

6. Click OK after you have finished.

You can also select  Record a sound annotation to the selected photo to 

record voiceover for a selected image. 

Like in video projects, add chapter points by selecting a photo and clicking Set 

current photo as chapter . To auto-set chapters at a regular interval, click 

Auto set chapter  and set the value for the interval.

Editing a slideshow
To edit your slideshow, select the slideshow thumbnail from the Media Clip list and 
click Edit Slideshow. Modify the selected slideshow in the Edit Slideshow dialog 
box.

Tips:

• Click Add All to include all the photos in the current directory.

• Click ExpressFix  to fix common digital photo problems.

• Select Match slideshow duration with background music duration to make 
the slideshow length the same as the length of the slideshow audio.
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Audio/Data Disc
Audio/Data Disc allows you to select recording tasks, formats, and storage media 
using Ulead Burn.Now. You can compile audio files and create MP3 Audio CD, DVD-
Audio, or Music DVD-Video discs. You can also create data discs and store both ISO 
and UDF file systems.

You can burn files and projects to CDs, DVDs, and dual-layer DVDs. You can also 
perform multi-session burning of dual-layer DVD-R using Layer-Jump Recording 
technology. Burn.Now also supports the next-generation Blu-ray Discs (BDs).

Please refer to the Burn.Now User Manual for details.

Import
Ulead DVD MovieFactory is capable of capturing video from different video sources 
such as DV and HDV camcorders and VCRs, analog devices, and TV tuners. 

Capture from devices
Capturing is the process of transferring video from your camcorder or other video 
sources to your computer. When you have properly set up your equipment for 
capturing, the video feed from your source device should be visible when you play 
the source tape in the Preview Window of the Capture Video dialog box. If your 
display card supports TV output connection, you will be able to view your video on 
a TV monitor.

Capture source devices are categorized into three classes: Analog TV, Digital TV, 
and DV Camcorder/HDV Camcorder. To capture video, click Import and then 
Capture from Devices in the Launcher. You can also click Capture Video in the 
Select source and import (Step: 1/3) page.

Capturing DV video
DVD MovieFactory allows you to capture digital video and automatically store it in 
your selected format. 

To capture DV video:
1. Connect your camcorder to the IEEE-1394 interface card. Turn it on and set it to 

Play (or VTR /VCR) mode. 
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2. In the Select source and import (Step: 1/3) page, click Capture Video 

. The Capture Video dialog box opens. The DV device connected to your 
computer is displayed in the Source list.

3. Select a Capture mode:

• Fixed duration sets the total duration to be captured. 
• Full DV tape captures the whole DV tape from tape start to end.

4. To adjust the capture options, click . 

• Format allows you to select the file format of the captured video.
• Capture folder shows the path of the folder where captured videos are 

saved. Click Browse to select a different folder.
• Advanced Settings lists additional capture settings.

5. Click Play in the Navigation Panel.

6. When you get to the part of the video to record, click Capture Video . 
Click Stop Capture or press [Esc] to stop capturing. The captured video will be 
added to the Captured videos list.

7. Repeat steps 5 and 6 to add more clips. Click OK after capturing to go back to 
the Select source and import (Step: 1/3) page. The captured clips are 
displayed in the Media Clip list.

Capturing High-Definition video (HDV)
Before capturing your HDV or HD video, make sure that your camcorder (or deck) 
is properly detected by your computer. 

On Sony HDV camcorder
If you have connected your Sony HDV camcorder before to your computer, check 
the Device Manager to see if your camcorder is detected as a DV device or AV/
C tape device. If the camcorder is detected as a DV device, you can capture DV 
footage. If your camcorder is detected as an AV/C tape device, you can capture 

HDV footage.

Note: Click Full Screen to toggle between the expanded or original view of the 
Preview Window.

Note: The Sony HDV camcorder can be detected only under Windows XP with Service 
Pack 2.
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To capture video from an HDV camcorder: 
1. Connect your HDV camcorder to the IEEE-1394 interface card. Turn it on and set 

it to Play mode. 

2. If you have a Sony HDV camcorder, make sure it is switched to HDV mode.

3. In the Select source and import (Step: 1/3) page, click Capture Video 

 to open the Capture Video page. The source device connected to your 
computer is displayed in the Source list.

4. In Advanced Settings, click Select Device Control and select HDV 1394 
Device Control from the Current device drop down menu.

5. Use the Navigation Panel to go to the start of the section of the video where 

you want to start capturing and click Capture Video .

Capturing analog video
DVD MovieFactory allows you to capture videos not only from digital sources, but 
also from analog sources. 

To capture video via an analog capture card:
1. Connect your video source device to your capture card. On some cards, you may 

also need to connect the audio cables. for S-video, please remember to connect 
the audio cable properly since S-video only transfers video signals.

2. In the Select source and import (Step: 1/3) page, click Capture Video. 
Follow the remaining steps as described in the procedure for capturing DV video. 
See “Capturing DV video” for more details.

Capturing TV footage
DVD MovieFactory allows you to capture TV footage with a TV tuner. Capture a 
segment of your favorite television show on regular TV or cable then save it in your 
hard drive in AVI or MPEG format.

To capture TV footage:
1. Check if your computer has an analog video capture card with a TV input jack. 

This jack usually uses a TV coaxial cable to input TV signals from either an 
antenna or a dedicated cable from your CATV supplier.

2. Connect your video source device to your capture card. On some cards, you may 
need to connect the audio cables.

3. In the Select source and import (Step: 1/3) page, click Capture Video.

4. Select your analog device from the Source list.
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5. Select the appropriate Capture mode.

6. Select the channel name and number in TV channel.

7. Select the appropriate video format from the Format list. 

8. Click Capture Video to start capturing.

9. Click Stop Capture or press [Esc] to stop capturing.

Capturing still images
In addition to video, DVD MovieFactory allows you to capture still images in BMP or 
JPEG. The dimensions of the captured image will depend on the frame size of the 
source video.

To choose your image format:
1. Return to the Select source and import (Step: 1/3) page and press [F6] to 

open the Preferences dialog box.

2. Click Capture tab and select the appropriate format in the Captured image 
format.

3. Specify the image quality (applicable only for JPEG format).

4. Click OK.

To capture still images:
1. Follow the steps in preparing to capture a video. See “Capturing DV video” for 

more details.

2. Scan your video to search for the part to capture.

3. When you get to the part of the video frame you want to capture, click Capture 
Image. 

Note: You can click TV Manager to edit the list of channels in the TV Channel 
Manager dialog box.

Tip: You can also capture a still image from a video clip in the Select source and 
import (Step: 1/3) page. Select the video clip from which you want to capture the 
still image and use the navigation buttons to locate the frame. Right-click the 
Preview Window and select Capture Image. You will then be prompted to save the 
captured image to your local folder.
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Capturing video directly to MPEG format
DVD MovieFactory allows you to capture video from a DV camcorder or analog 
source straight to MPEG.

To capture video in MPEG format:
1. Connect your camcorder or VCR to your capture card. Switch it on and set it to 

Play (or VTR/VCR) mode. 

2. Select a DVD, VCD, SVCD, or MPEG format in Format.

3. Click Capture Video to start capturing.

4. Click Stop Capture or press [Esc] to stop capturing.

Set Auto Capture to DVD
Ulead DVD MovieFactory allows you to set delayed recording times when capturing 
from different sources to DVD. You can specify the capture source, the time to start 
recording and the total recording duration.

To use Set Auto Capture to DVD:
1. Set the Capture Mode to Set Auto Capture. Then choose your recording 

source. 

2. Set the start time and total duration of the recording session. 

• The maximum total duration of recording depends on your available disc 
space.

• If the start time is earlier than the current time, DVD MovieFactory will start 
to record the day after.

3. Click Start Auto Capture to start the task. If you need to reset the start time 
and duration, click Stop Capture and reset the values before restarting the 
task.

 Import from DVD
Import video from your DVD discs and add them to your video projects. You can 
import all the DVD files or simply select specific titles and chapters. (Program 
imports track 1 audio in default.)

DVD MovieFactory also supports dual channel audio input so you can include the 
video’s main audio channel and/or the sub channel if available.

Note: A DVD player connected to an amplifier using an audio-optical-fiber cable may 
not be able to produce sound when playing an NTSC DVD with MPEG audio.
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To import DVD video:
1. Click Import and then Import from DVD in the Launcher. You can also click 

Import DVD Video or DVD-VR files from a disc or hard drive in the Select 
source and import (Step: 1/3) page. The Select a DVD Title dialog box 
opens. 

2. Locate the DVD drive that contains the video files and click Import.

3. The Import DVD dialog box opens.

4. In the left pane, select the video clips to import.

5. Click Import. The imported video files are displayed in the Media Clip list.

Note: Click Import DVD Folder to search your hard drive for the video files. 
Browse for the DVD folder and click OK.

Notes:

• Use the playback controls in the Preview Window to view each video clip or chapter.
• Black video thumbnails that appear in the Media Clip list indicate that the first 

frame in the video is either white or black.
• The number of chapters, angles, audio, and subtitle streams of the selected title 

track are displayed in Info located on the left pane below Disc label.
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Edit Disc
With DVD MovieFactory, you can modify videos and menus directly on a rewritable 
disc or add files and folders on an appendable disc. To edit a disc, click Edit Disc in 
the Launcher and select the type of disc to modify. 

You can also modify the contents of your disc by clicking Edit Disc in the DVD 
MovieFactory main program.

To edit a disc in the main program:
1. Insert the disc to edit and click Edit Disc.

2. Select the project to edit and click Next to add, modify, or remove videos/
menus.   

3. Preview your video project, and then click Next.

4. Click Burn. 

Copy Disc
Copy Disc lets you copy contents from one disc to another. You can also burn a 
disc image file or the contents of a DVD folder directly to disc.

To copy contents directly from a disc:
1. Click  Copy Disc in the Launcher and select the Copy Disc associated task. 

This opens the Copy Utility dialog box.

2. Specify the file to copy in Source. Select Browse for a DVD- video folder if 
the source file is from a disc or a DVD folder. 

3. In Destination, select the burner drive to use. You can also choose to convert 
the disc contents to a Disc image file for future use.

4. Click More advanced settings to specify burning options and then click Copy.

Selecting Convert DVD+VR/-VR Video to DVD-Video then Burn to Disc allows 
you to convert the VR format to DVD-Video so that your videos can be viewed on 
standard DVD players.

Notes:

• When editing a DVD movie recorded on DVD-R, the contents will first be copied to 
your hard drive. It will be burned onto a new disc after you have finished editing.

• You can only edit menus that were created in DVD MovieFactory.
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Disc Tools
Disc Tools allows you to format, erase, and close your disc.

Format Disc
Select Format Disc to open the Format Disc dialog box. DVD MovieFactory allows 
you to write the UDF (Universal Disc Format) file system to a rewritable disc to 
enable random packet writing. Random packet writing allows disc space to be used 
more efficiently when burning data onto the disc. It allows data to be written onto 
the disc in the same way as the hard disk, freeing disc space as data are deleted, 
and reusing freed space. A disc can be formatted with UDF 1.5 or above. 

Erase Disc
Select Erase Disc to open the Erase Disc dialog box. This allows you to erase the 
contents of your rewritable disc. 

Close Disc
Select Finalize Disc to open the Close Disc dialog box. Closing a recordable disc 
means that no further data can be written onto it.

Create Bootable Disc
If you are using the ISO 9660 or ISO 9660 + Joliet file system, you can select 
Create Bootable Disc to create a disc that allows your computer to automatically 
boot or start up without having to access the hard disk.

Tools
Settings and options
Opens a menu of options that allows you to set preferences, save projects, view the 
online Help and information about Ulead DVD MovieFactory, visit the Ulead DVD 
MovieFactory Web page, and register your copy of Ulead DVD MovieFactory.

Open
Opens an existing Ulead DVD MovieFactory project file (*.DWZ).
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Save
DVD MovieFactory (*.DWZ) file using the date as the file name. If you are just 
saving the changes you made in an existing project, its original file name will be 
retained.

Save As
Saves a copy of the current project.

Preferences
Select to set the program's working environment through the Preferences dialog 
box.

To open the Preferences dialog box, click Settings and options and select 
Preferences or press [F6].

General

• VCD player compliant Select to make sure that the VCD created will play in 
stand-alone VCD players. 

• Anti-flicker filter Select to apply the anti-flicker filter to the menu pages. 
The anti-flicker filter reduces the flickering that happens when using a 
television to view the menu pages. However, this does not help when the 
menu page is viewed on progressive scan devices such as computer monitors 
or projectors. Select this option if you plan to view the movie or slideshow on 
television sets.

• Always show relink message Select to automatically perform link-checking 
between the project clips and the associated source files. This is important 
when the source file is moved to another folder location or has been deleted.

• Resume all confirmation dialog boxes Select to have the confirmation 
boxes appear even after the “Do not show again” option is selected.

• Max 30MB menus for set-top DVD+VR recorder Select to set the 
maximum file size for DVD menus to 30MB to make DVD compatible with set-
top DVD (DVD+VR) recorders.

• Check Ulead Web site every XX days Select to specify how frequently the 
program checks the Ulead Web site for news and updates.

• Resample quality Specify the quality for all clips. A higher quality results in 
better video but takes longer time to render. Choose Best if you are 
preparing for final output. Choose Good for faster operation.

• TV system Select the type of your TV system (NTSC or PAL/SECAM).
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• Slideshow image duration Specify the default clip length for all image clips 
that will be used in your slideshow project. The duration is measured in 
seconds.

• Video transition effect duration Specify how long a video transition effect 
is displayed on screen.

• Audio fade-in/out duration Specify the amount of time it will take for the 
volume to reach normal levels when fading-in or the lowest level when 
fading-out.

• Working folder Enter or locate a folder for temporary files.

Advanced

• Create index file for MPEG seeking performance Improves real-time 
preview result using the Jog Slider. This option is specific for MPEG-1 and 
MPEG-2 files only.

• NTSC/PAL safe color Uses video friendly colors to ensure the display 
quality of your menus when viewed on any TV system. This helps you avoid 
the flickering problem on videos when viewed on screen.

• TV safe area Sets a margin (represented by a red border) in the Preview 
Window of the Select a template to create menu (Step 2/3) page. If you 
set the TV safe area at 10%, the remaining 90% will be your working area. 
Make sure that all your menu objects are within the working area so that they 
can be properly viewed on screen. 

Capture

• Click OK to start DV capture Launches a confirmation message before 
performing the actual capturing process.

• Stop tape once capturing stops Automatically stops the connected capture 
device in your computer once the program stops capturing.

• Captured image format Select either JPEG or Bitmap format for the still 
image that you captured.

• Image quality Specifies the quality of the captured JPEG image.

Disc Template Manager
Opens the Disc Template Manager dialog box. Here, you can add disc templates 
according to the disc format selected. You can also edit or delete existing disc 
templates.

Ulead DVD MovieFactory Help
Opens the Ulead DVD MovieFactory online Help.
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Product Updates on the Web
Opens the Ulead Web site to inform you about new updates & patches or product 
releases. This also gives you access to the latest offerings or promotions related to 
the product.

Online Registration
Launches your Web browser then takes you to the page on the Ulead Web site 
where you can register your copy of Ulead DVD MovieFactory.

About Ulead DVD MovieFactory
Displays product and copyright information about Ulead DVD MovieFactory.

Exit
Closes the program.

Project settings
Opens the Project Settings dialog box where you can view information about a 
specific project and customize its output settings.

• MPEG properties for file conversion Displays detailed information about 
the selected video’s settings.

• Change MPEG Settings Select the type of video setting for your project. 
Select Customize to personalize video settings.

• Display aspect ratio Select the output display of your project. DVD 
MovieFactory supports standard 4:3 and widescreen 16:9 display aspect 
ratios for videos and menus.

• Do not convert compliant MPEG files Select to prevent the program from 
rendering DVD-compliant MPEG files during the rendering (output) process.

• Support X-Disc Includes Extended disc (XDVD, XVCD, XSVCD) compatible 
files to your project.

• Two-pass conversion Improves the quality of the output video by analyzing 
the video data first before encoding.

• Treat MPEG audio as non-DVD compliant Select to treat all video files 
that has MPEG audio as non-HD-DVD compliant. The MPEG audio track will 
not be rendered to LPCM during output.

• Auto fade out first play to menu Select to automatically crossfade from 
the first play clip to the menu.
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• Play all clips first before menu Select to play all videos first, and then 
display the menu.

• Auto repeat when disc playback ends Select to automatically replay the 
video after disc playback ends.

• Clip playback Determines what to display next after the playback end of a 
video clip. Clear Auto repeat when disc playback ends to enable this item. 

Display aspect ratio
Toggles between standard 4:3 and widescreen 16:9 display aspect ratios for videos 
and menus.

You can also set display aspect ratio by clicking . This opens the Project 
Settings dialog box where you can select 16:9 in Display aspect ratio. The video 
clips and menus are then adjusted automatically.

Label@Once
Launches the Label@Once dialog box where you can create and print labels and 
covers for your discs. Label@Once allows you to design and print stunning discs 
labels and case covers for your discs. It lets you add and lay out images and text.

Label@Once dialog box
The General tab allows you to select a disc label or disc cover template to start 
with. You can then customize the overall design of the disc label, disc cover, insert, 
or booklet. The actual dimensions of your media or label in relation to the selected 
paper size is displayed to serve as your guide.

• Printer Select a printer to use.

• Media type Select the type of label to print. Choose from a variety of media 
types such as front and back CD covers, DVD case inserts and booklets, as well 
as mini disc labels.

• Paper size Select a paper template to work on or create your own customized 
template.

• Paper orientation Select whether to use Portrait or Landscape orientation for 
the paper.

• Copies Enter the number of copies to print.

• Currently selected label Displays a preview of the currently selected paper 
template.
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• Texture Select to use an image file as background for your disc label. Click 
Browse to select the image file to use.

• Color Select to use a solid color as background for your disc label. Click the color 
box to select your desired color.

• Transparency Adjust the transparency of the background by entering a value or 
using the slider.

The Image tab allows you to adjust images in your disc label or cover design.

• Brightness A higher value produces a brighter image.

• Contrast A higher value makes the midtone colors stand out more.

• Transparency Adjust the transparency of the image by entering a value or 
using the slider.

• Fit to Window Click to fit the image to the disc label or cover layout. The image 
will be stretched proportionally and centered horizontally and vertically.

• Shadow Select to apply a shadow to the image.

• Shadow color Click to choose the desired image shadow color.

• X-offset Enter the horizontal distance of the shadow from the selected image.

• Y-offset Enter the vertical distance of the shadow from the selected image.

• Transparency Adjust the transparency of the shadow by entering a value or 
using the slider.

The Text tab allows you to add and format text.

• Wrap text Select to wrap the text into a circle.

• Auto fill Click to fit the text to the disc label or cover layout. The text will be 
stretched proportionally and centered horizontally and vertically.

• Shadow Select to apply a shadow to the text.

• Shadow color Click to choose the text color.

You can also choose the following tasks to help you with designing your disc label.

Files

• Load Disc Label Click to open a previously saved disc label project.

• Save Disc Label Click to save your disc label project.

Add Image Click to select an image to add on the label.
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Add Text Adds a text object to the label.

Add Icon Adds an icon to the label.

Playlist Opens the Add/Edit Playlist Information dialog box to allow you to add 
information on the label such as the album title, artist name, as well as date.

Clear content Click to remove all objects and background from the disc layout. 
This is useful when starting over with your design.

Other options

• Show/Hide Disc Click to show/hide the outline of the disc for better 
alignment of images or text.

• Show/Hide Grid Click to show/hide gridlines for laying out images and text 
symmetrically.

Creating custom paper templates
DVD MovieFactory comes with preset paper templates that you can use as labels 
and covers for your discs. It also lets you create your own paper template.

To create a paper template:

1. Click  to open the Label@Once dialog box.

2. In the General tab, click  to open the Customize Paper Template dialog 
box.

3. Click Add to open the Edit Paper Template dialog box.

4. Enter a name for the template then set the unit of measurement in Unit and 
paper dimensions in Paper size.

5. To insert a disc label into the template, choose the disc size in Shape object 
and then click Insert. You can also insert CD and DVD covers by selecting a 
preset shape object from the list.

6. Click Close to go back to the Customize Paper dialog box.

7. To use the newly created template, select it in Paper size.
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Designing from scratch
When creating a disc label, you can add and customize the look of your images and 
text.

To add a background image to the disc label:
1. Click the General tab.

2. Select Texture under Background and click Browse to locate the image file to 
be used as texture. Click Open. The image will be tiled on the label. 

To use a solid color as the base of your disc label:
1. Click the General tab.

2. Select Color under Background and click the color box to select a color.

To add an image to your disc label:
1. Click Add Image to browse for the image to use. Click Open to add the 

selected image on the label.

2. Select the image in the Preview Window and use the handles to resize the 
image. To move an image, drag it to the desired position on the label.

3. To add more images, repeat steps 1 and 2.

To adjust the background:
1. Click the General tab.

2. To adjust the transparency of the background, use the Transparency slider to 
set the appropriate value.

To edit an image:
1. Select the image to edit.

2. Click the Image tab.

3. Adjust Brightness, Contrast and Transparency levels of the image by 
entering the value or using the slider.

4. Select Shadow to add a shadow to the selected image. Click the color box to set 
the shadow color, and adjust the X/Y offset values to set the shadow position.

Note: Only the part of the image inside the red boundary will appear when the label 
is printed.
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To add text to your disc label:
1. Double-click the disc image in the Preview Window and enter your text or click 

. This automatically activates the Text tab.

2. Format the selected text by adjusting the font type, size, style, text color, and 
alignment. Adjust the text Transparency level accordingly.

3. Click a thumbnail under Wrap text to make the text wrap around the disc label. 
Select Auto fill if the text is too short to make a circle.

4. Select Shadow to add a shadow to the selected image, and click the color box 
to set the shadow color. 

5. Adjust the X/Y offset values or use the shadow's round and green handles to set 
the shadow position. 

Designing based on an existing project
When your project has been completed and recorded onto a disc, it is time to 
create a disc label or cover.

To design a disc label based on an existing project:

1. Open an existing MovieFactory project and click . 

2. Initially, the background image used for the menu will also serve as background 
for your disc label. The menu title serves as the disc title and the menu 
thumbnail descriptions are used as track names.

3. Click Playlist as needed to open the Add/Edit Playlist Information dialog 

box. In Global Information, specify which information you want to include on 
the disc label such as the title, artist name, date created, and title or track 
names. To change a track/title name, double-click and enter a new text. 

4. You can also arrange the order or remove selected track/title names. Click OK to 
go back to the Label@Once dialog box.

5. Click Print to start the printing process or click Files: Save Disc Label to save 
your disc label project.

Tips: 

• Press [Ctrl] and click each element to select multiple elements.
• Right-click an element to open a pop-up menu that contains options for aligning 

elements, arranging their order, and more.

Note: Changing the disc title and track/title names in your label will not affect the 
menu title and thumbnail descriptions on your project.
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Designing based on a playlist
You can also design a label or cover for your discs based on a playlist. You can then 
use these as title or track names for your disc label.

To design a label based on a playlist:

1. Click . The disc label is displayed in the Preview Window of the 

Label@Once dialog box.

2. Click Playlist  to open the Add/Edit Playlist Information dialog box.

3. Click Import Playlist then browse for the playlist that you want to include on 
your label then click Open.

Importing a disc label
Open your previous disc label projects for re-editing or re-printing.

To open a previously saved disc label project:
1. Click Files: Load Disc Label.

2. Browse for the disc label file (*.UPL) to open in the Open dialog box.

3. Click Open to open the project.

Saving a disc label
After working on your disc label design, you can save it for use at a later time.

To save your disc label:
1. Click Files: Save Disc Label.

2. Browse for the folder where the disc label will be saved. Enter a name for the 
project and click Save to save the project.

Printing a disc label
To print your disc label:
1. In the General tab, select a printer from Printer list.

2. Enter the number of copies to print then click  or  to select the orientation 

of the paper. 

3. Click Print.
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DVDCopy
Clicking DVDCopy opens InterVideo DVDCopy that allows you to copy your 
movies, back up data discs, or merge multiply files on a single disc. You can also 
access this application by clicking its desktop icon, selecting the program from the 
Start menu, or from the program folder.

With DVDCopy, you can copy your DVDs, VCDs or SVCDs or other video files on to 
different types of discs in only three steps:

Step 1: Select the source of the original movie. Select a video from your 
available DVD or CD drive or a file on your hard drive. 

Step 2: Select or specify your target location for your copied files.

Step 3: Specify the file type to copy to. These are: DVD, DVD image, VCD, 
SVCD, DivX AVI/Media, WMV, 3GPP, 3GPP2, MP3, WMA, and WAV formats. 

You may refer to the InterVideo DVDCopy online Help for details.
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Glossary
Analog

A signal that continuously varies in 
frequency/quantity, rather than 
discrete units found in digital devices. 
Information from an analog source 
must be converted to digital in order for 
a computer to interpret it.

Aspect Ratio

The proportion of a picture’s width and 
height.

Burn

The process of writing or recording 
content to a CD or DVD.

Button

An object assigned to an attribute 
which, when clicked, performs a 
specific function. Buttons are 
commonly used to play an assigned 
chapter or move to the next or previous 
one.

Compression

The process of making a file smaller. 
Nearly all digital video is compressed in 
some way or another through a codec.

Device Control

A software driver that allows your 
computer to control video sources like 
the camcorder.

DV

Abbreviation for Digital Video, which is 
a very specific format of video. DV can 
be played back/recorded by your 
computer if you have the proper 
hardware (capture card) and software 
(DV codec).

Disc image files

Files that contain the entire content of 
a storage medium (e.g. CD-ROM).

Field order 

The order in which a field in interlaced 
video is displayed first during playback. 
This can either be Lower Field First or 
Upper Field First. A field is one of the 
two half-frames in interlaced video. 
Field order is not applicable for frame-
based videos which are displayed with 
complete single frame pictures.

HDV

Abbreviation for High Definition Video. 
It is the video recording format that 
allows for high data compression, and 
in turn allows for higher picture 
resolutions. HDV can go up to 1920 x 
1080 in resolution.

Introductory Video

The video clip that plays when the disc 
is inserted into the player.
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LPCM audio

Abbreviation for Linear PCM which is a 
high quality uncompressed audio 
format similar to CD audio, but with 
higher sampling frequencies and 
quantization. Bandwidth for video on 
a DVD video disc is lessened if LPCM 
audio is used.

Menu

A group of objects set against a 
background that allows navigation 
through the scenes or immediately 
proceed to a specific portion of the 
title.

Motion Menu

A menu that features animated 
backgrounds and/or buttons.

MPEG audio

A family of standards for low bit-rate 
coding of audio.

Normalize audio

This function evaluates and adjusts 
the audio waveform of video used in a 
movie according to the highest peaks 
and correcting the rest accordingly to 
avoid volume level variation.

NTSC

NTSC is the video standard in North 
America, Japan, and some other 
regions. Its frame rate is 29.97 fps 
and has a video resolution of 720x480 
pixels.

PAL

PAL is the common video standard in 
Europe, Australia, New Zealand, 
China, Thailand, and other Asian 
countries. It has a frame rate of 25 
fps, and has a video resolution of 
720x576 pixels.
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